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Preface

SQL*Plus Getting Started for Windows provides information about the SQL*Plus 
product specific to Microsoft Windows 2000, Windows NT 4.0, Windows 98, and 
Windows 95 operating systems. 

This preface contains these topics:

■ Audience

■ Organization

■ Related Documentation

■ Conventions

■ Documentation Accessibility

Notes: In the remainder of this guide, SQL*Plus for Windows, 
will be referred to as SQL*Plus. 
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Audience
SQL*Plus User’s Guide and Reference is intended for business and technical users 
and system administrators who want to use SQL*Plus in the Windows 2000, 
Windows NT or Windows 95/98 operating environments.

This guide assumes that you are familiar with:

■ SQL*Plus commands and general features. You should refer to the generic 
SQL*Plus documentation set before using this guide. See "Related 
Documentation" later in this chapter.

■ Commands for deleting and copying files and the concepts of the search path, 
subdirectories, and path names.

■ Fundamentals of the Microsoft Windows 2000, Windows NT or Windows 95/98 
operating systems.

To use this guide, you need a basic understanding of the SQL database language. If 
you do not have any familiarity with this database tool, you should refer to the 
Oracle9i SQL Reference. If you plan to use the PL/SQL database language in 
conjunction with SQL*Plus, refer to the PL/SQL User’s Guide and Reference for 
information on using PL/SQL.

Organization
This guide contains:

Chapter 1, "Introducing SQL*Plus"

Chapter 2, "Installing SQL*Plus Help and Demonstration Tables"

Chapter 3, "Using SQL*Plus"

Chapter 4, "Operating System-Specific References"

Appendix A, "Customizing Operating System Parameters"
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Related Documentation
SQL*Plus Getting Started for Windows provides information specific to SQL*Plus 
on Windows-based platforms only. For information about SQL*Plus 
cross-platform support, features, and commands, refer to the generic SQL*Plus 
documentation set on the product CD-ROM. For information on the new web 
browser-based user interface to SQL*Plus, iSQL*Plus, see the iSQL*Plus User’s 
Guide and Reference.

In addition to the complete documentation for the Oracle Enterprise Edition for 
Windows product, the following SQL*Plus documentation is available for 
online viewing:

■ SQL*Plus 9.0.1 Release Bulletin (for late-breaking information not included in 
the SQL*Plus documentation)

■ SQL*Plus User’s Guide and Reference

■ SQL*Plus Quick Reference

■ iSQL*Plus User’s Guide and Reference

Examples in this book use the sample schemas of the seed database, which is 
installed by default when you install Oracle9i. Refer to the Oracle9i Sample Schemas 
document for information on how these schemas were created and how you can use 
them.

In North America, printed documentation is available for sale in the Oracle Store at

http://oraclestore.oracle.com/

Customers in Europe, the Middle East, and Africa (EMEA) can purchase 
documentation from

http://www.oraclebookshop.com/

Other customers can contact their Oracle representative to purchase printed 
documentation.

Note: Before installing SQL*Plus, refer to the generic SQL*Plus 
documentation on the CD-ROM, and to the Release Notes and 
Readme files on the CD-ROM for late-breaking information. 
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To download free release notes, installation documentation, white papers, or other 
collateral, please visit the Oracle Technology Network (OTN). You must register 
online before using OTN; registration is free and can be done at

http://technet.oracle.com/membership/index.htm

If you already have a username and password for OTN, then you can go directly to 
the documentation section of the OTN Web site at

http://technet.oracle.com/docs/index.htm

Whitepapers, sample code, frequently asked questions and other useful information 
is regularly posted to the SQL*Plus section on OTN at

http://technet.oracle.com/tech/sql_plus/

Conventions
This section describes the conventions used in the text and code examples of this 
documentation set. It describes:

■ Conventions in Text

■ Conventions in Code Examples

■ Conventions for Windows Operating Systems

Conventions in Text
We use various conventions in text to help you more quickly identify special terms. 
The following table describes those conventions and provides examples of their use.

Convention Meaning Example

Bold Bold typeface indicates terms that are 
defined in the text or terms that appear in 
a glossary, or both.

When you specify this clause, you create an 
index-organized table. 

Italics Italic typeface indicates book titles or 
emphasis.

Oracle9i Database Concepts

Ensure that the recovery catalog and target 
database do not reside on the same disk.
x



Conventions in Code Examples
Code examples illustrate SQL, PL/SQL, SQL*Plus, or other command-line 
statements. If users are expected to type them into the system, they are identified by 
the keyboard icon shown in the margin following. They are displayed in a 
monospace (fixed-width) font and separated from normal text as shown in this 
example:

SHOW PAGESIZE

Similarly, output from an example is identified by a computer screen icon in the 
margin as shown in the margin following.

PAGESIZE 24

UPPERCASE 
monospace 
(fixed-width 
font)

Uppercase monospace typeface indicates 
elements supplied by the system. Such 
elements include parameters, privileges, 
datatypes, RMAN keywords, SQL 
keywords, SQL*Plus or utility commands, 
packages and methods, as well as 
system-supplied column names, database 
objects and structures, usernames, and 
roles.

You can specify this clause only for a NUMBER 
column.

You can back up the database by using the 
BACKUP command.

Query the TABLE_NAME column in the USER_
TABLES data dictionary view.

Use the DBMS_STATS.GENERATE_STATS 
procedure.

lowercase 
monospace 
(fixed-width 
font)

Lowercase monospace typeface indicates 
executables, filenames, directory names, 
and sample user-supplied elements. Such 
elements include computer and database 
names, net service names, and connect 
identifiers, as well as user-supplied 
database objects and structures, column 
names, packages and classes, usernames 
and roles, program units, and parameter 
values.

Note: Some programmatic elements use a 
mixture of UPPERCASE and lowercase. 
Enter these elements as shown.

Enter sqlplus to open SQL*Plus.

The password is specified in the orapwd file.

Back up the datafiles and control files in the 
/disk1/oracle/dbs directory.

The department_id, department_name, 
and location_id columns are in the 
hr.departments table.

Set the QUERY_REWRITE_ENABLED 
initialization parameter to true.

Connect as oe user.

The JRepUtil class implements these 
methods.

lowercase 
monospace 
(fixed-width 
font) italic

Lowercase monospace italic font 
represents placeholders or variables.

You can specify the managed_clause.

Run old_release.SQL where old_release 
refers to the release you installed prior to 
upgrading.

Convention Meaning Example
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Where both icons occur together, it implies interactive entry and output.

1 

  1* SELECT LAST_NAME, SALARY
APPEND , COMMISSION_PCT;

The following table describes typographic conventions used in code examples and 
provides examples of their use.

Convention Meaning Example

[ ] Brackets enclose one or more optional 
items. Do not enter the brackets.

DECIMAL (digits [ , precision ])

{ } Braces enclose two or more items, one of 
which is required. Do not enter the braces.

{ENABLE | DISABLE}

| A vertical bar represents a choice of two 
or more options within brackets or braces. 
Enter one of the options. Do not enter the 
vertical bar.

{ENABLE | DISABLE}

[COMPRESS | NOCOMPRESS]

... Horizontal ellipsis points indicate either:

■ That we have omitted parts of the 
code that are not directly related to 
the example

■ That you can repeat a portion of the 
code

CREATE TABLE ... AS subquery;

SELECT col1, col2, ... , coln FROM 
employees;

 .

 .

 .

Vertical ellipsis points indicate that we 
have omitted several lines of code not 
directly related to the example.

Other notation You must enter symbols other than 
brackets, braces, vertical bars, and ellipsis 
points as shown.

   acctbal NUMBER(11,2);

   acct    CONSTANT NUMBER(4) := 3;

Italics Italicized text indicates placeholders or 
variables for which you must supply 
particular values.

CONNECT SYSTEM/system_password

DB_NAME = database_name
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Conventions for Windows Operating Systems 
The following table describes conventions for Windows operating systems and 
provides examples of their use.

UPPERCASE Uppercase typeface indicates elements 
supplied by the system. We show these 
terms in uppercase in order to distinguish 
them from terms you define. Unless terms 
appear in brackets, enter them in the 
order and with the spelling shown. 
However, because these terms are not 
case sensitive, you can enter them in 
lowercase.

SELECT last_name, employee_id FROM 
employees;

SELECT * FROM USER_TABLES;

DROP TABLE hr.employees;

lowercase Lowercase typeface indicates 
programmatic elements that you supply. 
For example, lowercase indicates names 
of tables, columns, or files.

Note: Some programmatic elements use a 
mixture of UPPERCASE and lowercase. 
Enter these elements as shown.

SELECT last_name, employee_id FROM 
employees;

sqlplus hr/<your_secret_password>

CREATE USER mjones IDENTIFIED BY 
ty3MU9;

Convention Meaning Example

Choose Start > How to start a program. For example, to 
start Oracle Database Configuration 
Assistant, you must click the Start button 
on the taskbar and then choose Programs 
> Oracle - HOME_NAME > Database 
Administration > Database Configuration 
Assistant. 

Choose Start > Programs > Oracle - HOME_
NAME > Database Administration > Database 
Configuration Assistant

C:\> Represents the Windows command 
prompt of the current hard disk drive. 
Your prompt reflects the subdirectory in 
which you are working. Referred to as the 
command prompt in this guide.

C:\oracle\oradata>

HOME_NAME Represents the Oracle home name.

The home name can be up to 16 
alphanumeric characters. The only special 
character allowed in the home name is the 
underscore. 

C:\> net start OracleHOME_
NAMETNSListener

Convention Meaning Example
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ORACLE_HOME 
and ORACLE_
BASE

In releases prior to 8.1, when you 
installed Oracle components, all 
subdirectories were located under a 
top level ORACLE_HOME directory 
that by default was:

■ C:\orant for Windows NT

■ C:\orawin95 for Windows 95

■ C:\orawin98 for Windows 98

or whatever you called your Oracle 
home.

In this Optimal Flexible Architecture 
(OFA)-compliant release, all 
subdirectories are not under a top 
level ORACLE_HOME directory. There 
is a top level directory called 
ORACLE_BASE that by default is 
C:\oracle. If you install release 9.0 
on a computer with no other Oracle 
software installed, the default setting 
for the first Oracle home directory is 
C:\oracle\ora90. The Oracle 
home directory is located directly 
under ORACLE_BASE.

All directory path examples in this 
guide follow OFA conventions.

See Oracle9i Database Getting Started 
for Windows for additional 
information on OFA compliances and 
for information on installing Oracle 
products in non-OFA compliant 
directories.

Go to the ORACLE_BASE\ORACLE_
HOME\rdbms\admin directory.

Convention Meaning Example
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Documentation Accessibility
Oracle’s goal is to make our products, services, and supporting documentation 
accessible to the disabled community with good usability. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program Web site at

http://www.oracle.com/accessibility/

JAWS, a Windows screen reader, may not always correctly read the code examples 
in this document. The conventions for writing code require that closing braces 
should appear on an otherwise empty line; however, JAWS may not always read a 
line of text that consists solely of a bracket or brace.
xv
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Introducing SQL*Plus

This chapter provides introductory information to help you get started with 
SQL*Plus.

Specific topics discussed are:

■ Overview

■ Basic Concepts

■ Obtaining Online Help
lus 1-1



Overview
Overview
You can use the SQL*Plus tool with SQL (Structured Query Language) and its 
procedural language extension, PL/SQL. These database languages allow you to 
store and retrieve data in Oracle databases. PL/SQL allows you to link several SQL 
commands through procedural logic.

SQL*Plus enables you to manipulate SQL commands and PL/SQL blocks, and to 
perform many additional tasks. With SQL*Plus, you can:

■ Enter, edit, store, retrieve, and run SQL commands and PL/SQL blocks.

■ Format, perform calculations on, store, and print query results in the form of 
reports.

■ List column definitions for any table.

■ Access and copy data between databases.

■ Send messages to and accept responses from an end user.

■ Perform database administration.

SQL*Plus provides both a command line interface and a graphical user interface 
(GUI). See Chapter 3, "Using SQL*Plus" for more information.

Basic Concepts
The following definitions explain concepts central to SQL*Plus:

Concept Definition

command An instruction you give to an operating system, or software 
such as SQL*Plus or Oracle, to perform a particular task. 

SQL command A command to execute SQL statements.

SQL*Plus command A command to execute SQL*Plus statements.

block In PL/SQL, a group of SQL and PL/SQL commands related 
to each other through procedural logic.

table The basic unit of storage in Oracle.

query A read only SQL SELECT command that retrieves 
information from one or more tables.

query results The data retrieved by a query. 
1-2 SQL*Plus Getting Started



Obtaining Online Help
For definitions of other concepts that are relevant to SQL*Plus, see the glossary in 
the SQL*Plus User’s Guide and Reference.

Obtaining Online Help
Online help for SQL*Plus is available from the SQL*Plus command line during a 
session. The SQL*Plus help tables must be created and populated by the database 
administrator. See "Installing SQL*Plus Online Help" in Chapter 2 for information 
about installing SQL*Plus online help. 

report Query results formatted by you through SQL*Plus 
commands.

SQL buffer A buffer which stores the last SQL command or PL/SQL 
block that you entered in SQL*Plus.

screen buffer A buffer to store the data in the SQL*Plus application 
window.

Concept Definition
Introducing SQL*Plus 1-3



Obtaining Online Help
1-4 SQL*Plus Getting Started



Installing SQL*Plus Help and Demonstration Tabl
2

Installing SQL*Plus Help and

Demonstration Tables

This chapter provides information to help you install SQL*Plus components.

Specific topics discussed are:

■ Installing SQL*Plus

■ Installing SQL*Plus Online Help

■ Accessing Sample Tables
es 2-1



Installing SQL*Plus
Installing SQL*Plus
The CD-ROM insert that accompanies your product CD-ROM includes the 
following information about SQL*Plus:

■ System requirements

■ Installation instructions 

Installing SQL*Plus Online Help
Online help is available from the command line of either the graphical user 
interface or the command line interface while you are using SQL*Plus. The database 
administrator creates the SQL*Plus help tables and populates them with SQL*Plus 
help data.

Prerequisites
Before you can install SQL*Plus help, ensure that:

■ SQL*Plus is installed, otherwise, you cannot create and load the help tables. 

■ The default tablespace for the SYSTEM user is large enough to accommodate 
the help system. You must have at least 48K of free space.

■ The SQL*Plus help script files are available in 

%ORACLE_HOME%\SQLPLUS\ADMIN\HELP\ 

The help script files are:

■ HELPBLD.SQL – to drop and create new help tables. 

■ HELPUS.SQL – to populate the help tables with the help data. 

■ HELPDROP.SQL – to drop existing SQL*Plus help tables. 

■ The Windows command file, HELPINS.BAT, is available in

%ORACLE_HOME%\BIN\ 

Note: Before installing SQL*Plus, refer to the generic SQL*Plus 
documentation on the CD-ROM, and to the Release Notes and 
Readme files on the CD-ROM for late-breaking information. 
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Installing SQL*Plus Online Help
Installing SQL*Plus Help
SQL*Plus help is installed automatically during Oracle9i installation. There are also 
two ways to manually install SQL*Plus help:

Running a provided batch file from the command prompt
1. Set an environment variable, SYSTEM_PASS, to hold the SYSTEM user login 

with:

SET SYSTEM_PASS=SYSTEM/PASSWORD

where PASSWORD is the password you have defined for the SYSTEM user. The 
default SYSTEM user password is MANAGER. 

The HELPINS utility reads this login from SYSTEM_PASS to run successfully.

2. Run the batch file, HELPINS.BAT, from a command line prompt with:

C:\> %ORACLE_HOME%\BIN\HELPINS US

Running a provided SQL script from SQL*Plus
1. Run SQL*Plus as the SYSTEM user with:

C:\> SQLPLUS SYSTEM/PASSWORD

where PASSWORD is the password you have defined for the SYSTEM user.

2. Run the SQL script, HELPBLD.SQL, from SQL*Plus with:

SQL> @%ORACLE_HOME%\SQLPLUS\ADMIN\HELP\HELPBLD.SQL HELPPATH HELPUS.SQL

where HELPPATH is the path to the SQL*Plus help directory containing the file 
HELPUS.SQL. HELPPATH is usually:

%ORACLE_HOME%\SQLPLUS\ADMIN\HELP

Accessing SQL*Plus Help
To access SQL*Plus help, enter the following command in SQL*Plus:

SQL> HELP

If you know the topic for which you want help, enter the following command:

SQL> HELP topic
Installing SQL*Plus Help and Demonstration Tables 2-3



Accessing Sample Tables
where topic is a SQL*Plus help topic. 

To display a list of available help topics, enter one of the following commands:

SQL> HELP INDEX

or

SQL> HELP TOPICS

Example
To get help for the COLUMN command, enter 

SQL> HELP COLUMN

If you get a response that help is unavailable, check that you have correctly installed 
SQL*Plus help in the SYSTEM schema.

For more information about the HELP command, see Chapter 8, “Command 
Reference” in the SQL*Plus User’s Guide and Reference.

Accessing Sample Tables
Included with Oracle9i, are a number of sample schemas. The SQL*Plus tutorial and 
examples use the EMP_DETAILS_VIEW view of the Human Resources (HR) sample 
schema. This schema contains personnel records for a fictitious company. For 
information about unlocking and accessing the HR sample schema, see Chapter 1 of 
the SQL*Plus User’s Guide and Reference. For further information about the sample 
schemas included with Oracle9i, see the Oracle9i Sample Schemas guide. 

Note: Dates in the sample schemas use four digit years. As the 
default date format in SQL*Plus is DD-MM-YY, dates displayed 
show only a two digit year. To control the way dates are displayed, 
either use ALTER SESSION SET NLS_DATE_FORMAT 
=’DD-MM-YYYY’, or use the SQL TO_CHAR function in your 
SELECT statements .
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Using SQL*Plus

This chapter explains how to start and use SQL*Plus from both the command line 
interface and the graphical user interface, and describes the graphical user interface 
menu options.

Specific topics discussed are:

■ Using the Command Line Interface

■ Using the Graphical User Interface

■ Exiting SQL*Plus
*Plus 3-1



Using the Command Line Interface
Using the Command Line Interface
The SQL*Plus command line interface is standard on all operating systems.

If you are connecting to a remote Oracle database, make sure your Oracle 
Net/networking software is installed and working properly. For more information, 
see the Oracle9i Net Services Administrator’s Guide and the Oracle9i Database 
Administrator’s Guide for Windows. 

To start the SQL*Plus command line interface:

1. Select Command Prompt from Programs in the Start menu. A Command 
Prompt window appears.

2. Start SQL*Plus by entering

C:\> SQLPLUS

You can optionally include your login username and password separated by a 
slash (/), and a remote database name to connect to, for example:

C:\> SQLPLUS username/password@connect_identifier

Otherwise you will be prompted to enter your username and password. 

Interpreting Arguments in Windows
The rules for interpreting arguments in Windows commands are:

■ Arguments are delimited by white space.

■ A string surrounded by double quotation marks, for example, “this string”, is 
interpreted as a single argument.
3-2 SQL*Plus Getting Started



Using the Command Line Interface
■ A double quotation mark preceded by a backslash is interpreted as a literal 
double quotation mark.

Example
The following SET MARKUP command illustrates white space to separate 
arguments, the single string argument for HEAD surrounded by single quotes, and 
the escaped double quotes around Employees so that the characters are printed and 
not interpreted as string delimiters. 

SET MARKUP HTML HEAD ’<TITLE>Annual Report \"Employees\"</TITLE>’

For more information about SQL*Plus command line arguments, refer to the 
SQL*Plus User’s Guide and Reference.

Changing the Command Line Font and Font Size
You can use the Windows Command Prompt Properties dialog to set the font and 
font size used in the SQL*Plus command line interface. 

To Change the Command Line Interface Font and Font Size
1. Right click in the command line interface title bar. 

2. Click Properties. The Window Preview box displays the current window’s 
relative size on your monitor based on your font and font size selections. The 
Selected Font: box displays a sample of the current font. 

3. Click the Font tab.

4. Select the font size to use from the Size box. Raster font sizes are shown as 
width by height in pixels. TrueType font sizes are shown as height in pixels.

5. Select the font to use from the Font box.

6. Select the Bold Fonts check box if you want to use a bold version of the font. 

For more information about changing Windows Command Prompt properties, see 
Windows Help or click Help in the Command Prompt Properties dialog. For 
information about changing font face and size in the Windows Graphical User 
Interface (GUI), see "Changing the GUI Font and Font Size" later in this chapter.

Using a Special Character
To check if a font contains a particular character, for example, the Euro sign, enter 
the character’s decimal number equivalent in the SQL*Plus command line interface. 
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Using the Graphical User Interface
For example, the decimal number equivalent for the Euro sign is 128, so you would 
enter Alt+0128 to display it. If it appears correctly, the chosen font contains the Euro 
sign, otherwise you need to try another font. 

You can use the Windows Character Map utility to view the characters available in a 
font. Character Map also shows the decimal number equivalent for extended ASCII 
characters. You access the Character Map utility by selecting Start, Programs, 
Accessories and then clicking Character Map.

Using the Graphical User Interface
While the command line interface is a standard feature of SQL*Plus on all operating 
system platforms, the graphical user interface is a feature of SQL*Plus for Windows.

If you are connecting to a remote Oracle database, make sure your Oracle 
Net/networking software is installed and working properly. For more information, 
see the Oracle9i Net Services Administrator’s Guide and the Oracle9i Database 
Administrator’s Guide for Windows.

The graphical user interface can be started from the Windows menus, or from a 
Windows command prompt.

Starting the GUI from the Windows Menu
1. Select Programs in the Start menu. Then select Oracle - ORACLE_HOME, then 

Application Development, and click SQL Plus.

The SQL*Plus window appears displaying the Log On dialog.
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Using the Graphical User Interface
Enter a valid user name and password. If you are connecting to a remote Oracle 
database, enter the Oracle Net connect_identifier in the Host String field. See the 
Oracle9i Net Services Administrator’s Guide for more information about 
configuring and using Oracle Net connect_identifiers.

2. Click OK.

Starting the GUI from the Windows Command Prompt
1. Select Command Prompt in the Start menu. A Command Prompt window 

appears.

2. Enter

C:\> SQLPLUSW

The SQL*Plus graphical user interface starts. You can optionally include your 
login username and password separated by a slash (/), and a remote database 
name to connect to, for example:

C:\> SQLPLUSW username/password@connect_identifier

Otherwise enter the required information in the login dialog as described 
above. The Oracle SQL*Plus application window appears.
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Using the SQL*Plus Application Window
SQL*Plus displays the SQL command prompt in the application window.

To enter SQL and SQL*Plus commands, type each command at the SQL*Plus 
command prompt and press Enter.

Using the Mouse Buttons to Copy Text to the Command Prompt
You can use the mouse buttons to copy text from anywhere in the SQL*Plus 
interface to the SQL*Plus prompt in the same interface.

To copy text, select the text by clicking and dragging with the left mouse button. 
While still holding down the left mouse button, click the right mouse button. 
SQL*Plus copies the selected text to the SQL*Plus prompt.

Using the Command Keys
The following command keys have special functions in SQL*Plus:
 :

Key Function

Home Top of screen buffer 

End Bottom of screen buffer

Page Up Previous screen page

Page Down Next screen page

Ctrl+Page Up Show page on left of current screen page

Ctrl+Page Down Show page on right of current screen page

Alt+F3 Find

F3 Find next

Ctrl+C Cancels an operation running in SQL*Plus.

Ctrl+C Copies text - when no operations are running in SQL*Plus.

Ctrl+V Paste text 

Shift+Del Clear the screen and the screen buffer 
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Using the SQL*Plus Menus
This section describes menus in the SQL*Plus graphical user interface (GUI). 
Bracketed entries show keyboard shortcuts to that File Menu command. The 
rightmost column shows the equivalent command line interface command where 
applicable.

File Menu
The File menu has the following options:

Option Description of File Menu Option Command Line

Open The Open option retrieves a previously stored command file.

If you supply no file extension, SQL*Plus looks for command files with the 
.SQL extension. The command file should contain a single SQL or PL/SQL 
statement. It should not contain multiple statements or SQL*Plus 
commands.

GET filename

Save The Save option has three alternatives: Save Create, Save Replace, and Save 
Append.

SAVE

■ Save Create saves the contents of the SQL*Plus buffer in a command 
file. By default, SQL*Plus assigns the .SQL extension to command files. 
You can specify a different extension in the File name text box.

■ Save Replace replaces the contents of an existing file with the contents 
of the SQL*Plus buffer. SQL*Plus creates the file if it does not exist.

■ Save Append adds the contents of the SQL*Plus buffer to the end of the 
file you specify.

SAVE filename 
CREATE

SAVE filename 
REPLACE

SAVE filename 
APPEND

After you save a command file, you can:

■ Retrieve the file using the Open option on the File menu.

■ Edit the file using the Editor option on the Edit menu.

■ Run the file using the START or RUN commands from the SQL*Plus 
command prompt.

Save As The Save As option saves the contents of the SQL*Plus buffer in a command 
file.

By default, SQL*Plus assigns the .SQL extension to command files. You can 
specify a different extension in the File name text box.

SAVE filename

Spool The Spool option has two alternatives: Spool File and Spool Off. SQL*Plus 
for Windows does not support the SPOOL OUT clause.
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Edit Menu
The Edit menu has the following options:

■ Spool File stores query results in a file. By default, SQL*Plus assigns the 
.LST extension to spool files. You can specify a different extension in the 
File name text box. You can edit the results with the Editor option on 
the Edit menu, and print the file from a Windows text editor.

■ Spool Off turns off spooling.

SPOOL filename

SPOOL OFF

Run The Run option lists and executes the SQL command or PL/SQL block 
currently stored in the SQL buffer.

RUN

Cancel
(CTRL+C)

The Cancel option cancels an in-progress operation.

The Cancel keyboard shortcut is only available when a SQL*Plus operation 
is running in the SQL*Plus session. When no SQL*Plus operation is running, 
CTRL+C copies selected text.

Ctrl-C

Exit The Exit option commits all pending database changes and closes the 
SQL*Plus application window.

EXIT

Option Description of Edit Menu Option Command Line

Copy
(CTRL+C)

The Copy option copies selected text to the Clipboard.

After you copy text to the Clipboard, you can paste the text into other 
Windows applications, such as Microsoft Excel and Microsoft Word.

The Copy keyboard shortcut is only available when no SQL*Plus operations 
are running in the SQL*Plus session. When a SQL*Plus operation is running, 
CTRL+C cancels the running operation.

not applicable

Paste
(CTRL+V)

The Paste option pastes the contents of the Clipboard to the SQL*Plus 
command line.

Note: A maximum of 3625 characters can be pasted from the Clipboard to 
the SQL*Plus command line during a single paste operation.

not applicable

Clear
(SHIFT+DEL)

The Clear option clears the screen buffer and the screen of the SQL*Plus 
application window.

CLEAR SCREEN

Editor The Editor option has two alternatives: Invoke Editor and Define Editor.

■ Invoke Editor loads the contents of the SQL*Plus buffer into an editor. 
By default, SQL*Plus saves the file to AFIEDT.BUF. You can specify a 
different file name in the editor.

■ Define Editor defines the editor that is invoked.

EDIT

DEFINE_EDITOR
= editor name

Option Description of File Menu Option Command Line
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Search Menu
The Search menu has the following options:

Options Menu
The Options menu has the following options:

Option Description of Search Menu Option Command Line

Find
(ALT+F3)

The Find option searches for a character, a word, or a group of characters or 
words in the SQL*Plus application window. Find begins the search at the top 
of the displayed screen.

Note: When Find reaches the end of the displayed screen, it does not wrap 
and continue searching from the top of the screen buffer.

not applicable

Find Next
(F3)

The Find Next option finds the next occurrence of the search text. not applicable

Option Description of Options Menu Option Command Line

Environment The Environment option allows you to set system variables to alter the 
SQL*Plus environment for your current session. This dialog has three areas: 
Set Options, Value, and Screen Buffer.

Note: See "Setting Options and Values Using the Environment Dialog" on 
page 3-10 for examples of how these controls interact.

Set Options

This area has a list of variables you can select to establish aspects of the 
SQL*Plus environment for your current session, such as:

■ Setting the display width for NUMBER data.

■ Setting the display width for LONG data.

■ Enabling or disabling the printing of column headings.

■ Setting the number of lines per page.

See the “Command Reference” chapter in the SQL*Plus User’s Guide and 
Reference for descriptions of each system variable in the SET command.

SET variable value

Value

The Value area has four options: Default, Custom, On, and Off.

Note: When Custom is selected, the On and Off buttons and the text field 
may or may not be enabled for user selection. The availability of these fields 
depends on the item selected in the Set Option. 

SET variable value
Using SQL*Plus 3-9



Using the Graphical User Interface
Help Menu
The Help menu has the following option:

Setting Options and Values Using the Environment Dialog
Choose Environment from the Options menu to display the Environment dialog 
which you can use to create a SQL environment statement for the current session. 

Choose an item from the Set Options list to begin. You can use the default settings, 
or you can customize the settings by using the other dialog controls. The available 
controls vary with the options you choose. You can make multiple changes to 
options and values. When the text box is available, you can enter appropriate text or 
appropriate numeric values. Click OK to commit your settings. 

Screen Buffer

This area has two text boxes: Buffer Width and Buffer Length.

SET variable value

■ In the Buffer Width text box, you set the number of characters that 
SQL*Plus displays on one line. If you enter a number smaller than the 
length of output data, SQL*Plus truncates the data to match the buffer 
width you specified. The default value of the Buffer Width parameter is 
100 characters. You can specify from 80 to 1000 characters on one line.

■ In the Buffer Length text box, you set the number of lines that SQL*Plus 
displays on the screen. If SQL*Plus displays more lines of data than you 
specify, the remaining lines of data will “wrap around” to the top of the 
screen buffer. The default value of the Buffer Length parameter is 1000 
lines. You can specify from 100 to 2000 lines on one screen.

Notes: When you change the Screen Buffer option, SQL*Plus displays a 
dialog to alert you that if you shorten the size of your screen buffer, some 
data may not be displayed on your screen. Click OK to proceed.

If you use SET MARKUP to send output to a HTML table, the number of 
lines specified in the Buffer Length variable specifies the number of HTML 
table rows. Each HTML table row may contain more than one text line.

Option Description of Help Menu Option Command Line

About 
SQL*Plus

Displays the SQL*Plus version number and copyright information.

You access SQL*Plus help from the SQL*Plus prompt. See "Accessing 
SQL*Plus Help" in Chapter 2.

not applicable

Option Description of Options Menu Option Command Line
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Example 3–1

The ARRAYSIZE is set to 15, the default value. 

To change the ARRAYSIZE, click Custom and enter the number in the text box.

Note: Options introduced after SQL*Plus Release 8.1.6 can only be 
accessed through the command line and are not available in the 
SQL*Plus for Windows Environment dialog. These options are:

SET MARKUP

SET SQLPLUSCOMPATIBILITY {ON|OFF}

See “Command Reference” in the SQL*Plus User’s Guide and 
Reference for descriptions of these SET commands.
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Example 3–2

The default for ECHO is off. To change the setting, click Custom and then click 
On. 

Changing the GUI Font and Font Size
There are two registry entries that set the font and font size used in the SQL*Plus 
Windows GUI. SQLPLUS_FONT sets the font face, and SQLPLUS_FONT_SIZE 
sets the font size in pixels. You use the Windows Registry Editor to create these two 
registry entries and define values for them. Ensure that you create the correct 
entries in uppercase, and that the font names you enter are correct. If you enter an 
incorrect name, the default font Fixedsys, and size 16, are used.

You can choose any fixed-pitch TrueType font available in your Windows system 
such as Courier New or Lucida Console. If you choose a proportional pitch font 
such as Arial or Times New Roman, or if you enter an unavailable font, the registry 
entry is ignored and the default font and size, Fixedsys 16, are used. If you choose 
an unavailable font size, the default font size, 16, is used.

If you do not create the SQLPLUS_FONT registry entry, or if you do not specify a 
value for SQLPLUS_FONT, the default font and size, Fixedsys 16, are used.

If you want to use particular characters, such as the Euro sign, you should make 
sure that the fixed pitch font you choose contains those characters. 

Warning: Microsoft does not recommend modifying the registry. 
Editing the registry may affect your operating system and software 
installation. Only advanced users should edit the registry. Oracle 
takes no responsibility for problems arising from editing the 
Windows registry. 
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To Change the Windows GUI Font and Font Size
1. Select Run from the Start menu and then enter regedit in the Open field. 

2. Click OK to start the Registry Editor. The Registry Editor is displayed.

3. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME0.

4. Click New String Value in the Edit menu. A new string value, with the default 
name, NewValue #1 is created at the bottom of the right pane of the Registry 
Editor. The default name of the new string value is selected ready for you to 
replace with the name you want. 

5. Enter SQLPLUS_FONT as the name of the new font face string value. If you 
miskey the name or inadvertently enter it in mixed or lower case, you can edit 
the name by selecting Rename from the Edit menu.

or

Enter SQLPLUS_FONT_SIZE as the name of the new font size string value. If 
you miskey the name or inadvertently enter it in mixed or lower case, you can 
edit the name by selecting Rename from the Edit menu.

6. Click Modify from the Edit menu or press Enter again to display the Edit String 
dialog.

7. Enter the font name you want to use, such as Courier New, in the Value Data: 
field. SQL*Plus will use the new font the next time you start the SQL*Plus 
Windows GUI.

or

Enter the font size you want to use in pixels, such as 14, in the Value Data: field. 
SQL*Plus will use the new font size the next time you start a SQL*Plus 
Windows GUI.

Note: If you have more than one Oracle installation, you must 
select the HOME entry associated with the Windows GUI you want 
to change. HOME0 is the registry entry for an Oracle installation. A 
subsequent Oracle installation will have the registry entry HOME1 
and the next HOME2 and so on. 

Changes only affect a SQL*Plus Windows GUI started from the 
associated Oracle installation, so you can use different settings for 
each Oracle installation.
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Using a Special Character
To check if a font contains a particular character such as the Euro sign, enter the 
character’s decimal number equivalent in the SQL*Plus Windows GUI. For 
example, the decimal number equivalent for the Euro sign is 128, so you would 
enter Alt+0128 to display it. If it appears correctly, the chosen font contains the Euro 
sign, otherwise you need to try another font. 

You can also use the Windows Character Map accessory to view the characters 
available in a font. Character Map also shows the decimal number equivalent for 
extended ASCII characters. You access the Character Map accessory by selecting 
Start, Programs, Accessories and then Character Map. 

Exiting SQL*Plus
You enter EXIT or QUIT at the SQL*Plus prompt to exit SQL*Plus from the 
command line interface or from the GUI.

You return to the Windows Command Prompt when you exit either the command 
line interface, or the GUI if you started it from the command line with SQLPLUSW. 

Click Exit from the File menu to exit from the GUI. The GUI closes and you return 
to Windows when you exit SQL*Plus from the GUI.

Note: You should not change the font face or font size while any 
SQL*Plus Windows GUI is active. You should exit all SQL*Plus 
Windows GUI sessions, make font face and font size changes in the 
registry, exit the Registry Editor and then restart the SQL*Plus 
Windows GUI to see the changes. 
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Operating System-Specific References

This chapter provides the operating system-specific information that is referenced 
in the SQL*Plus User’s Guide and Reference.

Specific topics discussed are:

■ Automatic Login

■ TIMING Command

■ Interpreting Error Messages

■ Setting Up Your SQL*Plus Environment

■ Sending Results to a File

■ @, @@, and START Commands

■ HOST Command

■ SET NEWPAGE Command

■ PRODUCT_USER_PROFILE Table
ences 4-1
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Automatic Login
When connecting to an Oracle database on the same Windows computer, you can 
set up SQL*Plus to do an automatic login by following these steps:

1. Create an account in the database <PREFIX>USERX for every Windows user 
(USERX) who needs access to the database. <PREFIX> is the parameter OS_
AUTHENT_PREFIX in the initialization parameter file for the database (the 
default is OPS$). See the Oracle9i Database Reference and the Oracle Advanced 
Security Administrator’s Guide for more information about the OS_AUTHENT_
PREFIX initialization parameter.

2. After logging on to Windows as USERX, you can log in to SQL*Plus using / 
(slash) instead of username/password.

See “Shortcuts to Starting SQL*Plus” in Chapter 2 of the SQL*Plus User’s Guide and 
Reference which refers you to this guide for information about automatically logging 
on to SQL*Plus when you log on to your operating system.

TIMING Command
The SQL*Plus TIMING command displays output in hours, minutes, seconds and 
hundredths of seconds. For example, 02:31:07.55 is 2 hours, 31 minutes and 7.55 
seconds. 

See “Collecting Timing Statistics on Commands You Run” in Chapter 2 and the 
sections “SET” and “TIMING” in Chapter 8 of the SQL*Plus User’s Guide and 
Reference which discuss how to use the TIMING command and the SET TIMING 
command to record timing data for an elapsed period.

Interpreting Error Messages
See “Interpreting Error Messages” in Chapter 2 of the SQL*Plus User’s Guide and 
Reference and this guide for information about interpreting error messages. See the 
SQL*Plus User’s Guide and Reference to find explanations and actions for error codes 
beginning with the letters SP2 and CPY. See the Oracle9i Database Error Messages to 
find explanations and actions for error codes beginning with the letters ORA.

If you do not find the error code in Oracle9i Database Error Messages, see Oracle9i 
Database Administrator’s Guide for Windows.
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Setting Up Your SQL*Plus Environment
When you install SQL*Plus, LOGIN.SQL is copied to the DBS subdirectory, and 
GLOGIN.SQL is copied to the SQLPLUS\ADMIN subdirectory of your Oracle 
home directory.

If you modify LOGIN.SQL or GLOGIN.SQL, make sure you do not add any ANSI 
escape sequences.

See “Setting Up Your SQL*Plus Environment” in Chapter 3 of the SQL*Plus User’s 
Guide and Reference, which describes the LOGIN.SQL and GLOGIN.SQL files.

Sending Results to a File
When you use the SPOOL command from the graphical user interface or the 
command line interface, SQL*Plus adds .LST to the file name if you do not specify 
an extension.

The SPOOL command is available from the File menu in the SQL*Plus graphical 
user interface. See "File Menu" on page 3-7 for more information.

SQL*Plus does not support the use of the SPOOL OUT clause at the command line.

See “Sending Results to a File” in Chapter 4 and “Spool” in Chapter 8 of the 
SQL*Plus User’s Guide and Reference, for more information about the SPOOL 
command.

@, @@, and START Commands
SQL*Plus searches the current default directory for the file name that you specify 
with the @, @@, or START command. If SQL*Plus cannot find this file, the program 
searches a path to find the file.

You can specify the path that SQL*Plus searches by modifying the SQLPATH 
parameter in your registry. For more information about the SQLPATH parameter, 
see the "SQLPATH Parameter Description" in Appendix A.

See the sections “@ (at sign)”, “@@ (double at sign)”, and “START” in Chapter 8 of 
the SQL*Plus User’s Guide and Reference, which describe how SQL*Plus searches for a 
file when you use the @, @@, or START command.
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HOST Command
In SQL*Plus, you can access the Windows command prompt by entering the HOST 
command or a dollar sign ($) at the SQL*Plus prompt.

To return to SQL*Plus from the Windows command prompt, enter exit.

See “HOST” in Chapter 8 of the SQL*Plus User’s Guide and Reference, which 
describes how to use the HOST command to execute a host operating system 
command without leaving SQL*Plus.

SET NEWPAGE Command
The SET NEWPAGE 0 command does not clear the screen between pages. Instead, a 
black box appears in the GUI, or another character in the command line interface.

See “SET” in Chapter 8 of the SQL*Plus User’s Guide and Reference, which describes 
how to set the NEWPAGE system variable, as well as many other system variables. 
It is recommended that you use SET NEWPAGE NONE.

PRODUCT_USER_PROFILE Table
The PRODUCT_USER_PROFILE (PUP) table provides product-level security that 
supplements the user-level security provided by the SQL GRANT and REVOKE 
commands and user roles.

To create the PUP table

Log in to SQL*Plus as the SYSTEM user and run PUPBLD.SQL which is located 
in the ORACLE_HOME\SQLPLUS\ADMIN directory with:

 SQL> @%ORACLE_HOME%\SQLPLUS\ADMIN\PUPBLD.SQL 

or

1. Set an environment variable, SYSTEM_PASS, to hold the SYSTEM user login 
with:

C:\> SET SYSTEM_PASS=SYSTEM/PASSWORD

where PASSWORD is the password you have defined for the SYSTEM user. The 
default SYSTEM user password is MANAGER. 

PUPBLD.BAT reads this login from SYSTEM_PASS to run successfully.

2. Run the batch file, PUPBLD.BAT, from a command line prompt with:
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C:\> %ORACLE_HOME%\BIN\PUPBLD.BAT

If you are using SQL*Plus with a remote database, you may want to install the PUP 
table on the remote database. To do this, run PUPBLD.SQL on the server directly, or 
set the LOCAL parameter in your registry to point to the remote database and then 
run PUPBLD.SQL.

See the “PRODUCT_USER_PROFILE Table” in Appendix E of the SQL*Plus User’s 
Guide and Reference for a description of the PUP table.

The PUP table is not used for ODBC connections. If you are unsure, you can usually 
identify ODBC connections from the form of the connection identifier. For ODBC 
connections, the connection identifier begins with odbc: or oca:. 
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Customizing Operating System Parameters

This chapter describes how to customize your SQL*Plus configuration by changing 
the SQLPATH parameter in the registry.

Specific topics discussed are:

■ Using the Registry

■ SQLPLUS Environment Variable

Warning: Microsoft does not recommend modifying the registry. 
Editing the registry may affect your operating system and software 
installation. Only advanced users should edit the registry. Oracle 
takes no responsibility for problems arising from editing the 
Windows registry. 
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Using the Registry
When you install Oracle products for Windows, Oracle Universal Installer adds 
relevant parameters to the Windows registry.

The following table indicates which registry version(s), REGEDT32.EXE or 
REGEDIT.EXE, you can use for your particular Windows platform: 

The HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE subkey contains the Oracle 
parameters.

See the Registry Editor’s help system for instructions on how to edit the registry 
entries defining Oracle parameters.

If you change the value of an Oracle parameter or add a parameter to the registry, 
the change will take effect whenever SQL*Plus executes a procedure that uses the 
parameter.

SQLPATH Parameter Description
The SQLPATH parameter specifies the location of SQL scripts. It is defined in the 
SQLPATH registry entry. SQL*Plus searches for SQL scripts in the current directory 
and then in the directories specified by the SQLPATH parameter.

The HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME0 registry subkey 
contains the SQLPATH registry entry. SQLPATH is created with a default value of 
\ORACLE\ORA90\DBS. You can specify any directories on any drive as valid 
values for SQLPATH.

When setting the SQLPATH parameter, you can concatenate directories with a 
semicolon (;). For example:

C:\ORACLE\ORA90\DATABASE;C:\ORACLE\ORA90\DBS

See the Registry Editor’s help system for instructions on how to edit the SQLPATH 
registry entry.

Windows Platform REGEDT32.EXE REGEDIT.EXE

Windows 2000 YES YES

Windows NT 4.0 YES YES

Windows 98 NO YES

Windows 95 NO YES
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SQLPLUS_FONT Parameter Description
The SQLPLUS_FONT registry entry defines the font face used in the SQL*Plus 
Windows GUI. It is located in the registry subkey, HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE\HOME0. If the SQLPLUS_FONT entry is not 
created, or if it has an invalid name or value, the default face, Fixedsys, is used. 

See "To Change the Windows GUI Font and Font Size" on page 3-13 for details on 
how to create the SQLPLUS_FONT registry entry and set the font face. See the 
Registry Editor’s help system for instructions on how to edit the SQLPATH registry 
entry.

SQLPLUS_FONT_SIZE Parameter Description
The SQLPLUS_FONT_SIZE registry entry defines the font size used in the SQL*Plus 
Windows GUI. It is located in the registry subkey, HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE\HOME0. If the SQLPLUS_FONT_SIZE entry is 
not created, or if it has an invalid name or value, the default size, 16, is used. 

See "Changing the GUI Font and Font Size" on page 3-12 for details on how to create 
the SQLPLUS_FONT_SIZE registry entry and set the font size. See the Registry 
Editor’s help system for instructions on how to edit the SQLPLUS_FONT_SIZE 
registry entry.

SQLPLUS Environment Variable
The SQLPLUS environment variable specifies the location of SQL*Plus message 
files. This environment variable is set during installation and has a default value of

%ORACLE_HOME%/SQLPLUS/MESG

You should not modify or set this environment variable. 
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$ command, 4-4
@ command, 4-3
@@ command, 4-3
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basic concepts, 1-2
block, defined, 1-2
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C:\ORANT, defined, Preface-xiv
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connect_string

See connect_identifier
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editor
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environment
command, 3-9
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File menu, 3-7
finding text, 3-9
font

changing face and size in CLI, 3-3
changing face and size in GUI, 3-12, 3-13
changing in GUI, 3-12
fixed pitch TrueType, 3-12
Oracle Home, 3-13

G
GLOGIN.SQL file, 4-3
graphical user interface

See GUI
GUI

changing face and size, 3-12, 3-13
changing font, 3-12
menus, 3-7
Windows Character Map utility, 3-14

H
help

accessing online help, 2-3
installation prerequisites, 2-2
installing, 2-2

Help menu, 3-10
HOST command, 4-4
host string, 3-5

I
installing

SQL*Plus online help, 2-2

L
LOCAL parameter, 4-5
Log On dialog, 3-4
LOGIN.SQL file, 4-3

M
menus

GUI, 3-7
mouse, using to copy commands, 3-6
MS-DOS, accessing from SQL*Plus, 4-4
multiple Oracle homes

specifying font, 3-13

N
net_service_name

See connect_identifier

O
online help

accessing online help, 2-3
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installing, 2-2
obtaining for SQL*Plus, 1-3, 2-2

operating systems, supported by 
SQL*Plus, Preface-vii

Options menu, 3-9
ORA error messages, 4-2
Oracle Home

specifying font, 3-13
ORACLE_BASE

explained, Preface-xiv
ORACLE_HOME

explained, Preface-xiv
overview, 1-2
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parameter

SQLPATH, 4-3, A-2
SQLPLUS_FONT, 3-12, A-3
SQLPLUS_FONT_SIZE, 3-12, A-3

pasting text, 3-8
PL/SQL, relation to SQL*Plus, 1-2
prerequisites

installing online help, 2-2
PRODUCT_USER_PROFILE table, 4-4
PUPBLD.SQL file, 4-4
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Q
query

defined, 1-2
results defined, 1-2

R
REGEDIT.EXE, A-2
REGEDT32.EXE, A-2
registry

editor, 3-12, A-2, A-3
SQLPATH entry, 4-3, A-2
SQLPLUS_FONT entry, 3-12, A-3
SQLPLUS_FONT_SIZE entry, 3-12, A-3

report, defined, 1-3
rules, for Windows arguments, 3-2
Run menu command

lists and executes SQL and PL/SQL, 3-8

S
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saving, command files, 3-7
screen buffer area, 3-10
Search menu, 3-9
security

PRODUCT_USER_PROFILE table, 4-4
sending results to a file, 4-3
SET NEWPAGE command, 4-4
Set Options area, 3-9
SET TIMING command, 4-2
setting up, using LOGIN and GLOGIN, 4-3
shortcuts to starting SQL*Plus, 4-2
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choosing a font, 3-3
Euro sign, 3-3, 3-12, 3-14
using, 3-3, 3-14

SPOOL command, 4-3
spool files, 4-3
spool menu command, 3-7
SPOOL OUT clause, not supported, 4-3
SQL*Plus

application window, 3-5
basic concepts, 1-2
command defined, 1-2

command line interface, 3-2
exiting, 3-14
installing, 2-2
installing online help, 2-2
menus, 3-7
overview, 1-2
setting up environment from command line, 4-3
setting up environment from GUI, 3-9
shortcuts to starting, 4-2
using LOGIN and GLOGIN to setup, 4-3
Windows versions supported, Preface-vii

SQL*Plus Windows GUI
changing face and size, 3-12, 3-13
changing font, 3-12

SQLPATH parameter, 4-3, A-2
SQLPLUS Environment Variable, A-3
SQLPLUS_FONT parameter, 3-12, A-3
SQLPLUS_FONT_SIZE parameter, 3-12, A-3
START command, 4-3
Start menu location, for SQL*Plus, 3-4
starting

SQL*Plus, 3-2
SQL*Plus Windows GUI, 3-4

subkey, registry, A-2, A-3
system requirements, 2-2
system variables, setting, 3-9

T
tables

defined, 1-2
demonstration, 2-4

text editor
defining, 3-8
invoking, 3-8

TIMING command, 4-2

V
value area, 3-9
value screen area, 3-9
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Windows GUI

changing face and size, 3-12, 3-13
changing font, 3-12

Windows Operating Systems
versions supported, Preface-vii
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